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Welcome to PickSync!

Thank you for installing PickSync!

To use its core function, PickSync is simple and intuitive - though with many powerful features just a click
away.  But you can (and you probably should) review the Key Concepts here.

You can also review a list of Features, suggested Applications, and a note on the built-in Safety features
below. And see Better than Windows Explorer! for many more reasons to use PickSync for regular file
browsing.

The core function

The basic function of PickSync is to display the contents of two different folders side-by-side in a grid,
with the file names each listed in alphabetical order and with matching names placed side-by-side.

You, the user, may then easily compare the contents of these folders, and copy or move selected
files from one side (i.e. one folder) to the other.  So use it e.g. for rearranging folder contents, or for backing
up.  Choose a file, a selection of files, or whole folders with or without subfolders. 

In short, you pick what you want to sync!

The side-by-side layout of the foldersʼ contents looks like this:



PickSync-help

4 / 70

The layout makes it easy to see exactly how the folder contents differ, and which files have changed. (Black
rows match, coloured rows donʼt!). You then have complete control over which files are selected for copying,
moving, or deletion.

PickSync provides a multiplicity of powerful options to select classes of files, and of folders and subfolders,
to be displayed in the grid. It is easy to select just the newer files in a folder, or just the unique ones, or just
matching ones (duplicates which can then be removed from one folder).  You can also filter by file name, or
by file date and/or file size, and can set lower and/or upper bounds for these properties.

Frequently-used pairs of folders can be saved, grouped as pairs, for regular reuse.

There is also a rich feature set for working with image files, for searching for files, and for saving a list
of files as a text document.  See the Features page for details.

Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

Features

I wrote PickSync for my own personal use, and have used it on a daily basis for many years. As a result it
has numerous features, large and small, which have been developed and refined over time to enhance its
usefulness, streamline its operation and help me efficiently manage my own files.

In addition to its core functionality described above, there are many further features:

· The ‘Fave (Favourite) Foldersʼ button allows you to save your most-used pair of folders, and then
subsequently to select them quickly.

· There are options to display only filenames matching a particular subset of text, or a particular size,
or a particular date: see file name filters and the Filter tab.

· There are options to display all subfolders, or only those which match on both sides, or only those
in one of the chosen folders.

· Searching for a particular file is easy, with a number of options.

· You can save a list of the files in the grid to a text document, as shown on either side or on both
sides (tab separated), with or without their dates/sizes.

· Image files have special functions provided: they can be viewed in Thumbnails, or in a separate
Picture Viewer.  

· Animated .gif files can be viewed as intended, in their original size or enlarged..

· Files can be renamed, and matching files on both sides of the grid can be renamed at the same
time.  Groups of files can be renamed all at once by adding a prefix or suffix, or replacing a phrase
within the filename with another.

· There is a "Safe Mode" which merely simulates all operations but without making any actual
changes to your disk contents.  This permits experimentation if you are unsure about the
consequence of any action.

https://www.helpndoc.com
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Finally, there is of course an uninstaller, which will completely remove PickSync from your system.  I do
hope that you won't, but you should feel confident to install it, knowing that you could easily uninstall it
again if you wanted to.

The Applications page describes some obvious, and some less-obvious, usage scenarios.
See also Better than Windows Explorer! for many more reasons to use PickSync for regular file browsing.

PickSync with its image viewer - excellent for .jpg images, even better for animated .gif files:

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Applications

I would be interested to hear how you use PickSync.  

To get you started, here is a short list of suggested applications:

· Backing up your 'My documents' folder (with or without subfolders), or other chosen folders, to a
separate hard drive, a USB drive, or a USB stick. Be selective, choose the changes.

· Copying modified documents from home to work, and vice versa, using a USB stick or USB drive.

· Transferring photos from camera memory to hard disk.  

· Rearranging collections of media, e.g of downloads, photos or MP3 files, on your hard drive -
create new folders and shuffle your files.

· Renaming those photos - to add a descriptive filename to a group of them all at once - while you
do so.  See Renaming groups of files.

· Selectively copying from a smaller disk or USB drive to a larger one, or (more selectively) from a
larger to a smaller one.

Try these:

https://www.helpndoc.com/help-authoring-tool
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· Pick your best photos to copy into a new, more selective, folder. Open a Picture Viewer window,
use the down arrow key to scroll through the main folder, and use the ‘Cʼ key to copy the ones you
most like into another folder with a single keystroke. Much faster than drag-drop.

· Combine IE favorites onto a USB stick that you can use to synchronise the favorites, or any
selected group of favorites, from all your computers. Each link is a separate file, usually stored by
Windows in C:\users\[yourusername]\favorites. Open that folder on one side of PickSync and copy
across whatever links you choose, then copy back all or selected links to the favorites
folder/subfolders on your other computers.

· Find and remove duplicates (see the sample application explaining how to do so).

And indulge your Paranoia (or prudence? – prevention is better than cure!):

· Paranoia (1) - check up on your usual backup program, or check a folder copy operation which you
performedusing Explorer. Did it copy everything, did it miss anything?  Did it change any file
names/dates?

· Paranoia (2) - perform separate local backup of selected critical files/folders, in case your cloud-
based service loses your data. 

· Paranoia (3) - maintain a separate local backup, in case iTunes somehow deletes your media on
your computer (you tried to sync to the wrong device?), and it then helpfully also ‘updatesʼ your
iDevice to empty: or you accidentally let Dropbox simultaneously delete ALL copies of a file from all
your PCs.

If you don't completely trust your cloud storage provider, then you should use PickSync for local backup! 
(Go Google "cloud data loss" now - then come right back here!).

PickSync is particularly useful for incremental backup - you have a large collection of files to save, but
only a few of them will have changed between backups. PickSync lets you review differences between the
current versions and the most recent backup, and copy across only those that are needed.

You can of course do all these things the brute force way, by simply copying a folder in Windows Explorer,
and sometimes that may be the quickest way.  However PickSync is for power users: it gives you detailed
information and fine control over what is moved.

Remember to use the ‘Fave (favourite) Foldersʼ button.  This allows the immediate selection of a pre-stored
pair of folders.  Any or all of the suggested applications above can be set up with such a pair, and then used
daily or as often as desired.  Use the button to save the currently selected pair, or to apply a previously
saved pair.

See also Better than Windows Explorer! for many more reasons to use PickSync for regular file browsing.

If you have more than one PC (a desktop and a laptop, or a PC and home and another at work), or if you
have a USB memory stick or USB hard drive, then you will find PickSync useful, if not indispensable.

Created with the Personal Edition of HelpNDoc: Easily create EBooks

Safety features

PickSync is designed with the aim of handling data as safely as it can.  It has been carefully tested - I have
used successive versions for my own data (including constantly saving and moving its own source code) on

https://www.helpndoc.com/feature-tour
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a daily basis for many years, literally thousands of times.  It contains internal checks and it provides
warnings of potentially problematic operations. 

It has never failed me.  Although I have used it thousands of times, both in testing and as a daily work tool, I
have never lost data as a result.  The safety features are summarised below.  

Safe Mode

You can experiment with its "Safe Mode" (click the 'Safe' button at top right). 

When on, all operations are simulated and NO changes at all are made to the content of your
hard disk (refreshing the display will confirm this).  

As explained in the notes on Safe Mode, when 'on' it traps and prevents any operations which
may in particular:

· Create a new folder; 

· Copy a file or files;

· Move a file or files;

· Delete a file or files.

File deletion

When not in Safe Mode, PickSync's 'Delete' operation will by default try to dispose of files in
the Windows Recycle bin, from which they can be restored if necessary.  (But note that some
types of storage, e.g. some USB sticks, do not have a Recycle bin).

By default, confirmation will be requested before a single file is deleted (but this option can be
turned off in the 'Options' tab if you wish).

Confirmation will always be requested before multiple files are deleted: see Deleting a file. 
Here, there is a choice between deleting files to the Recycle Bin if possible (which may be slow
due to the way that Windows saves them), or deleting them permanently (which is faster but
cannot later be undone).
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Folder operations

PickSync operates on files not folders.  You cannot copy or move an entire folder just by selecting a folder
row (but of course you can individually copy or move all the files within it).

You cannot delete a folder with its contents using PickSync (this is for your own safety, but again if you
wish you can select and delete all the files within a folder).  There is however a tool to delete all empty
subfolders (which can be useful for cleaning up a folder after files have been moved out of it).  For details see
the Tools menu on the main menu strip.

Confirmation of operations

The Options tab allows you to set options so that PickSync will seek confirmation before carrying out
operations that move or change data.

The options set by default are shown above - they will provide a warning asking for confirmation
if any file is to be deleted or overwritten.

Mitigation of user error

I cannot completely prevent user error, in spite of all the safety measures above.  PickSync is a
powerful tool for copying and moving data.  If you try to overwrite or delete copies of your files,
and give any requested confirmations, then PickSync will let you do so - it can only assume
that that is what you intended.

PickSync is of course also dependent on the correct operation of your hardware and of your
Windows installation (all copies moves and deletions are performed using functions within
Windows itself).

However, the various features set out above, if used sensibly, mean that in general the worst
that can happen as a result of user error is that data will be moved to an unintended location
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(but not lost), or to the recycle bin when available (from which they can be restored).

I believe that PickSync is as safe with data as a tool of its kind can be.  I have used it myself
on a daily basis for many years - among other things, to back up its own source code! 
Nonetheless, it is still appropriate that a disclaimer in customary form (viz. no warranties
whatsoever!) is contained in the licence under which you use it.  After all, these are the same
terms under which I use it myself !

Created with the Personal Edition of HelpNDoc: Easily create EBooks

Better than Windows Explorer!

Why and when you should use PickSync rather than Windows Explorer : 

Better than Windows Explorer (1)

The dual folder display provides much more functionality than just two instances of Windows Explorer. The
side-by-side aligned view enables immediate detailed comparison of the contents of two folders. Unless the
folder contents are almost identical, that is too hard and too error-prone to do by eye in Explorer.

Windows Explorer : two closely similar folders.  How quickly can you see how their contents differ?

  

PickSync shows the difference immediately.  Four files are identical, one is present only in one folder:

PickSync will also indicate when identically named files have different dates, or sizes.  You can then easily
copy newer versions over older ones.

Sample application: Finding and removing duplicates

Sometimes identical copies of files end up in more than one folder and you may want to find or remove one
of the copies. This can easily be done as follows:

· Open the folder containing the unwanted duplicates on the left side of PickSync. 

· Open the folder with the copies you want to keep on the right. 

https://www.helpndoc.com/feature-tour
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· In the main panel, use the drop-down menu to select ‘Identicalʼ files, and click ‘Go!ʼ. 

· The grid now displays all duplicated files. 

· Select the unwanted ones on the left.

· Right-click, select “Delete”, and after a confirmation dialogue, they will be gone. (Alternatively, if you
are cautious and want to check, select “Move To”, and choose a temporary folder to which to move
them).

This procedure will remove the exact duplicates, but leave in place all files in both folders that are not
exactly duplicated in the other. 

Better than Windows Explorer (2)

Moreover, simply for browsing files, PickSync has many further, very useful, advantages over Windows
Explorer:

· Previewing image files is much easier in the separate Picture Viewer.  PickSync also makes a
great animated .gif viewer.

· By selecting all subfolders, you can easily produce a complete listing of the files in a folder and all
its subfolders at the same time.

· The comprehensive filtering options (simple filtering for file name and more fine-grained filtering in the
Filter tab) make it easy to zoom in on hard-to-find files, or quickly list all files of a particular kind. 
You can display only files before/after/on/between certain dates, or within specified file sizes.

· The Search tab also provides various search options within the displayed list of files.

· You can save a list of the files shown in the grid to a text file, as shown on either or both sides (tab
separated), with or without dates/sizes, with or without all subfolder contents.  This can be printed
or edited externally, or easily copied into other documents.

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

Key concepts - basic features

The basic function of PickSync is to display the contents of two different folders side-by-side in a GRID, with
the file names each listed in alphabetical order and with matching names placed side-by-side.

You, the user, may then easily compare the contents of these folders, and copy or move your selected files
from one side (i.e. one folder) to the other.  When you do, the display is updated to reflect the operation. 
You can also delete files.

This is how the main window appears in normal use, with labels to show the key features and concepts:

https://www.helpndoc.com/help-authoring-tool
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At the top is a conventional Windows menu strip, with File, View, Tools, Help dropdown menus.
Below this is a row of buttons including Fave (Favourite) Folders and Safe Mode.
The left and right folder trees, one on each side, are used to select folders.  
These folder trees flank the central panel, containing the GO button, and other controls laid out in tabs.
In the lower part is the grid, containing lists of files with the file name, date, and size displayed.

The grid

The grid is divided into left and right halves, with file or folder information on each side.  These are
separated by a column of comparison characters in the middle (see below). 

Most rows are file rows (white, or yellow if selected), but there can also be folder rows (grey) or information
rows (pink).

The comparison character

The column in the middle of the grid contains a single character in each row.  This may be blank (no
operation possible), or may be
   = if the files on both sides are considered identical.
   > if the file on the left is newer.
   <   if the file on the right is newer.

You can copy or move files in the direction indicated by the chevron.

By default, 'newer' by default compares the dates of the files.  However, the "Size overrides date" checkbox
in the central panel, if checked, makes a comparison based on file size rather than date.  "Newer" then
becomes "larger".
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The REFRESH button: Updating the grid

Click the "REFRESH!" button in the central panel to refresh the list of files displayed in the grid.

Selecting folders and files

The simplest method of selecting the folders to be opened in the grid is to use the left and right folder trees.
 Other ways of selecting folders are listed here.  You can choose whether or not to display subfolders.

You can limit the types of files to be displayed from those folders in a variety of ways: by how they match
the contents of the other folder, by the filename filter, or by further filters.

You can select files in single or multiple rows.  Note that you select one side of the grid, left or right.

Copying moving and deleting files

These are core functions.  After you have selected a single file or multiple files, they can be copied or moved
or deleted.  When you do so the contents of the grid are updated to reflect the result of the operation.  Use
the buttons on the top row, the right-click menus, or the keyboard shortcuts to select these operations.  

The contents of the grid will be updated to reflect the result of the operation.  

Safe mode

Safe mode prevents PickSync from making any changes at all to the contents of your computer.  It
simulates the effect of copy move or delete operations by updating the grid as if they happened, but without
actually performing them.  It therefore permits and encourages experimentation.  For further details see 
here.

Confirmation of operations

By default, PickSync will ask for confirmation before overwriting or deleting a file, or creating a folder.  By
default, confirmation is not asked for other copy or move operations, but you can change this in the
"Options" tab.

Messages

PickSync often provides confirmation messages when its operations are completed, or sometimes when
they cannot be.  They normally persist for a few seconds and then disappear.  To get rid of a message
immediately, click it.  To ensure that it remains visible for more than a few seconds, hover the mouse over it.

Created with the Personal Edition of HelpNDoc: Free CHM Help documentation generator

Five simple points to note

Here are some introductory points to note, for first-time users:

1. The grid is divided into two halves, left and right

https://www.helpndoc.com
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Since the grid displays the contents of two separate folders, you can't select an entire row as a whole - you
select the left or right half of a row.  

Coloured highlighting indicates which side of the grid is selected. 
The 'comparison character' in the middle indicates whether the files are the same, or the direction in which
any copy or move will take place if they are not.

Here, the second and third selected rows can be copied across:

Here, by contrast, nothing will be copied across - the wrong side is selected! :

You can change the selected side with the left/right arrow keys, or by clicking on a file on the other side.

2. Selecting groups of files

Clicking one row will select it.  To select more than one row, use Shift-Click or Control-Click, just as with
other Windows programs.  

You can also use the two 'Select' buttons ("Select All files" and "Select Folder") at the top left.  

See also Selecting a file or files below.

3. Save your favourite pairs of folders for re-use

The "Fave Folders" button is near the top left of the main window.  Use it to set, or subsequently re-use,
pairs of folders (e.g a source and target folder for your backups).  See further the Fave (favourite) Folders
topic below.

4. PickSync is simple and intuitive to use

The program is powerful, but its core functionality is simple. Its more powerful features are logically placed,
out of the way to avoid clutter, but easily available if and when you need them.

Hovering the mouse over any control will bring up a 'tooltip', briefly explaining its function:
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Right-clicking in the grid will bring up a menu of possible operations, tailored to the particular type of file. 
See right-click menus below.

5. Experiment using 'Safe Mode'

When safe mode is on, all file operations will be simulated.  No changes to the content of your disks will
be made.

So, for example, if a Copy or Move operation is selected, the grid will be updated as if that operation had
taken place - but no file will be copied or moved, and the contents of both the left and right folders will
remain unaltered.  

So if you don't feel confident about what any particular operation might do, put PickSync into Safe Mode and
then try it!  See Safe Mode below.

Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

Selecting a folder

PickSync compares the contents of two folders.  So there are two separate folders that need to be selected
- the one on the left and the one on the right. In general, they should be different (but need not be - see
below).

Note that selecting a new folder does not generally refresh the grid.  (It could be annoying if it happened
prematurely, for instance when one folder has been selected but not the other).

However the "REFRESH" button will be illuminated pink, to indicate that it needs to be clicked to refresh.

Until the grid is refreshed, some operations on the files in the grid will not be permitted.

The simplest way to change the selected folder is using the folder trees in the top corners:

https://www.helpndoc.com
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Clicking a folder node once will select the folder: double-clicking will select it and also immediately refresh
the grid.

It is also possible to select a folder in a number of other ways:

· Enter the folder name in the drop-down combo boxes and press the 'Return' key.

· Click the down-arrow in the drop-down combo box, then use the drop-down list to select a folder
that has previously been opened in this session.

 

· Drag a folder from another window (e.g. Windows explorer), and drop it into the drop-down combo
boxes, or onto the left or right side of the grid.

· Use the ‘Fave (favourite) Foldersʼ button, to select a pair of folders that you have saved there.

· Right-click a folder name row within the grid, and use the "Up one level" or "Down a level" command
to open the pair of folders in that row.

Single column mode

Although the left and right folders should usually be different, there may be reasons to make them the same:
it may make the list of files clearer, and you can then use PickSync like an enhanced version of Windows
Explorer (with filtering, and/or with subfolder contents listed). 

If you set the left and right folders to be the same, then PickSync will switch from its normal dual-column to
a single-column format: 
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You can still use the Picture Viewer and most of the right-click menu options (but obviously not Copy
Across or Move Across).

Changing one of the selected folders - thereby making the selected folders different again - will revert back to
the normal two-column mode.

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Selecting a file or files

Each row in the grid presents either a file in one or other folder, or a pair of files having matching names in
both folders.

Selection of a file or files involves both:

· Choosing the row (or rows, see below), and 

· Choosing which side of the grid (left or right) is desired.

Choosing a single row

To select an individual file or file pair, simply click on that row.
The selected row will be highlighted.  

Further, the file on the selected side will be more brightly highlighted.

The selected side depends on whether you clicked on the left or right hand half of the grid.

The keyboard arrows (up, down, page up, page down) will change the selected row.
The left and right arrow keys, or the 'X' keyboard shortcut, will change the selected side.

Choosing multiple rows of files

This can be done in a number of ways:

· Clicking while the Shift or Control keys are held down (similar to Windows Explorer).

· Using the "Select All" button. This will select every row in the grid.

· Using the "Select Folder" button.  This will select every file which is in the same folder as the
currently selected row.

When multiple rows are selected, all the files on the selected side (left or right) are highlighted.
The most recently selected one (the 'focused' file) is more brightly highlighted.

https://www.helpauthoringsoftware.com
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Note that the highlighting will also extend to the comparison character, if and only if copying or moving that
file across to the other side of the grid is permitted.

In the example shown above, clicking the "Copy Across" button:

· will copy the file DSC01006 to the other side: that file is on the selected side and so the > comparison
character is highlighted.

· will not copy the file DSC01007 to the other side: that file is not on the selected side and so the <
comparison character is not highlighted.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Copying and Moving files

Copying or moving a file or files from one side of the grid to the other is straightforward:

· Select the file or files to be moved, on the appropriate side, and

· Perform the copy or move.

Note that a copy or move will only be permitted and performed if the comparison character is '>' (for files to
be moved from left to right side) or '<' (for the other direction).

Selecting the file or files

If a single row is selected: 

The movement will be in the direction of the comparison character, regardless of whether the left or the right
side is the selected side (with the brighter highlight).

If multiple rows are selected:

https://www.helpndoc.com
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In this case a copy or move will only be performed in the case of rows where the comparison character is
also highlighted.  The selected side therefore matters.

Performing the copy or move

This can be achieved in several different,equally valid, ways:

· The "Copy Across" and "Move Across" buttons at the top right

· The keyboard shortcuts 'C' or 'M' (for copy or move respectively)

· The right-click menu.

Note the following:

· If "Safe Mode" is selected, the grid will be updated to show what the result of the copy or move
would have been, but no files are actually transferred.

· Depending on what options are selected, you may be prompted to confirm the operation.

· A new folder will be created if necessary, and again you may first be prompted to confirm this.

Copying or Moving to another folder

PickSync's core functionality is to copy or move files across the grid, from the selected folder on one side to
that on the other side.

However it is sometimes convenient to move a file or files elsewhere, without having to change the selected
folders.

The Copy To and Move To commands are therefore provided.   They are described here.

Folders : Copy or Move

PickSync will not permit copying or moving of a folder together with its contents, merely by selection of the
folder name.  There are too many possibilities for unexpected results or error!

Selecting a (sub)folder name in the grid and trying to copy it will 'copy' the folder name: it will create a new
subfolder having that name in the folder on the other side, if such a folder does not already exist.  It will not
copy that folder's contents: this can be done in a separate step by then selecting the relevant files and
copying them.

Trying to move a folder name is not permitted and has no effect.  Moving the contents of a folder should be
done by selecting and moving its files individually.
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Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

Deleting files

Deleting a single file

To delete a single file:

· Right-click the file in question, on the appropriate side of the grid, and then select 'Delete' in the right-
click menu
or

· Select the file in the grid and then use the keyboard shortcut key 'D', or the keyboard's "Delete" key.

Confirmation is requested if the "Confirm Deletes" checkbox on the Options tab is checked.

The file will normally be deleted to the Recycle bin if possible, from which it can be recovered if you made a
mistake or change your mind.  However it is possible to have it permanently deleted (you may prefer this if it
is a very large file).  

Deleting more than one file

Multiple files can also be deleted.  Select a group of files and then, as above, use the right-click menu, the
'D' keyboard shortcut, or the "Delete" key.

Where multiple files are selected for deletion, they may be deleted to the Recycle bin if possible, or
permanently deleted.  Recycling may take longer, due to the way Windows saves backup copies, but it is
safer.  Permanent deletion is faster, but non-reversible.  You are offered the choice in a dialog box as shown
below:

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Folders cannot be deleted in this way (this is for your own safety: you can of course select and delete all
the individual files within a folder).

There is however a tool to delete all empty subfolders (which can be useful for cleaning up a folder after files
have been moved out of it and its subfolders).  For details see the Tools menu on the main menu strip.

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Safe Mode

PickSync is designed with the aim of handling data as safely as it can. 

In order to provide still further reassurance, Safe mode is provided in order to let users experiment, without
making any accidental changes to the computer or the contents of its drives and folders. 

When safe mode is on, all file operations will be simulated.  

So, for example, if a Copy or Move operation is selected, the grid contents will be updated as if that
operation had taken place - but no file will be copied or moved, and the contents of both the left and right
folders will remain unaltered.

Safe mode, if on, traps and prevents any operations which may:

· Create a new folder; 

· Copy a file or files;

· Move a file or files;

· Delete a file or files.
Each is however simulated in the grid contents, as explained above.

Safe mode was originally created merely for debugging purposes, but I later found that it was worth keeping,
especially for new users!

To select Safe mode, click the "Safe" button at the top right.

https://www.helpndoc.com/help-authoring-tool
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When safe mode is on, the button will be coloured red. 

 
 
There will also be a warning shown next to the "REFRESH" button:

Now experiment - try to copy, move or delete a file.  The contents of the grid will be updated as if that
operation had taken place.  But click the "REFRESH" button and note that all files have remained where
they were!

Created with the Personal Edition of HelpNDoc: Free help authoring environment

Fave (favourite) Folders

The 'Fave (favourite) Folders' button accesses a separate form allowing the saving or the selection of your
most-used pairs of folders.

The "Fave Folders" button is near the top left of the main window, with a slight blue tinge to draw attention to
it.

Clicking the button opens the "Favourite Folder Pairs" form:

https://www.helpndoc.com/help-authoring-tool
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The central portion displays a list of pairs of folders.  Double-clicking a row will close this form, and will open
the selected pair of folders in PickSync and refresh the grid.  The same will happen if you select a row and
then click the big "Apply selected Favourite pair" button.

Obviously, the purpose is to select pairs of folders that you often synchronise: e.g. your "My Documents"
folder and your USB stick.

Note also that the first pair in the list will be selected and opened when PickSync starts up.  Choose the
pair that you wish to use when you start PickSync, and make it the first in the list.

You can save a pair of folders to your Favourites as follows:

· Select them in PickSync and refresh the grid;

· Click the "Fave Folders" button.

· Click the "Add current folder pair" button (at the top left of the form).

There is a nominal maximum of 100 pairs. You can delete a row using the "Delete" button, which will delete
the selected row.

You can rearrange the order in which entries appear using the "Move up" and "Move down" buttons at the
top right, which will change the position of the currently selected row.  In particular, use them to change the
top row, which will change the folders selected when PickSync first starts up.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

Key Concepts in more detail

Here is some further detailed explanation of the main PickSync window.

This is how the main window appears in normal use, with labels to show the key features and concepts:

https://www.helpndoc.com/feature-tour
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At the top is a conventional Windows menu strip, with File, View, Tools, Help dropdown menus.
Below this is a row of buttons including Fave (Favourite) Folders and Safe Mode.
The left and right folder trees, one on each side, are used to select folders.  
These folder trees flank the central panel, containing the GO button, and other controls laid out in tabs.
In the lower part is the grid, containing lists of files with the file name, date, and size displayed.

The grid

The grid is divided into left and right halves, with file or folder information on each side.  These are
separated by a column of comparison characters in the middle (see below).

The side-by-side layout of the foldersʼ contents looks like this:

The layout makes it easy to see exactly how the folder contents differ, and which files have changed. (Black
rows match, coloured rows donʼt!). You then have complete control over which files are selected for copying,
moving, or deletion.

Rows in the grid are of three kinds: file, folder, or information.
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File rows are white, unless selected.  They contain a file name, the file date/time, and the file size in bytes.
 

These details are given for the file on the left and for the file on the right.  The comparison character is in the
middle.

A newer file on the left side, which can therefore be copied to the right side, is coloured blue.  If there exists
an (older) file on the right side with the same name, it is coloured grey rather than black.

Similarly, a newer file on the right side is coloured red.

Folder rows are grey, unless selected.  They contain only folder names.

If the folder exists on both sides, the names are in black and there is no comparison character.

If a (sub)folder does not exist on one side, the name is greyed out.  
A '<' or '>' comparison character then indicates that the folder name on the other side can be 'copied' to
create a new (initially empty) subfolder of that name.

Information rows are pink.

No operations on them are possible; they are inserted purely for information.  

The comparison character

The column in the middle of the grid contains a single character in each row.  This may be blank (no
operation possible), or may be
   = if the files on both sides are considered identical.
   > if the file on the left is newer.
   < if the file on the right is newer.

Copying within PickSync is only possible from the newer to the older, i.e. in the direction indicated by the
comparison character.
(Tip: to copy the other way, if you really must, delete the newer file first, then copy the older one into the
space left after the deletion).

One further point to note here: 'newer' by default compares the dates of the files.  
However, the "Size overrides date" checkbox in the central panel, if checked, makes a comparison based
on file size rather than date.  
In that case, since the comparison is based on size, files are considered identical if they have the same
size, and the 'newer' file is instead the larger file, irrespective of file date.

The REFRESH button: Updating the grid

Click the "REFRESH!" button in the central panel to refresh the list of files displayed in the grid.

Note that in general:

· The grid is not automatically refreshed when the files contained in a selected folder change, other
than by copy/move/delete operations performed by PickSync itself (this could be very annoying
indeed if other Windows processes are also accessing a selected folder at unpredictable times).
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· The grid is not automatically refreshed when you change one of the folders which is selected (it
could be annoying if it did so uninvited, for instance when you intend to change the other folder as
well).

But in the latter case, the "Refresh" button turns red to indicate that a refresh is required.  Similarly, it will
turn red to indicate that a refresh is needed if any selection parameters (e.g file filters or subfolder options)
are changed 

Selecting folders and files

The simplest method of selecting the folders to be opened in the grid is to use the left and right folder trees.
 Click once to select, or double-click to select and refresh the grid.  Other ways of selecting folders are
listed here.

You can limit the types of files to be displayed from those folders in a variety of ways: by how they match
the other folder, by filename, or by further filters.

You can choose whether or not to display subfolders.

Copying moving and deleting files

These are core functions.  After you have selected a single file or multiple files, they can be copied or moved
or deleted.  When you do so the contents of the grid are updated to reflect the result of the operation.  Use
the buttons on the top row, the right-click menus, or the keyboard shortcuts to select these operations.  

The contents of the grid will be updated to reflect the result of the operation.  

Safe mode

Safe mode prevents PickSync from making any changes at all to the contents of your computer.  It
simulates the effect of copy move or delete operations by updating the grid as if they happened, but without
actually performing them.  It therefore permits and encourages experimentation.  For further details see 
here.

Confirmation of operations

By default, PickSync will ask for confirmation before overwriting or deleting a file, or creating a folder.  

Picksync will not usually ask for confirmation of copy or move operations, but it can do if you want it to do
so.  You can change this behaviour in the Options tab.  Note that these options are presently not preserved
if you exit and then restart PickSync.
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Messages

PickSync often provides confirmation messages when its operations are completed, or sometimes when
they cannot be.  These appear in the middle of the grid for a few seconds and then disappear by themselves
without any further intervention being needed.  

To get rid of a message immediately, click it.  To ensure that it remains visible for more than a few seconds,
hover the mouse over it.  If you want to see the text again after the message box has disappeared, use the
View | Repeat Last Message command.

Created with the Personal Edition of HelpNDoc: Free CHM Help documentation generator

Further features

This section contains explanations of the following topics:

Matched and unmatched files: How to limit the files being displayed, depending on their relationship to the
contents of the other folder.

Subfolders: How to display the contents of subfolders of the selected folders.

File name filters: How to display only files which meet selection criteria for the file name.

Keyboard shortcuts: How to control PickSync using the keyboard.

https://www.helpndoc.com
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Copying and moving to another folder: How to copy or move files to any other folder.

  

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Matched and unmatched files

The 'Main' tab in the central panel provides options for selecting particular classes of matched and
unmatched files.

Ordinarily, by default, the grid will display all files, in both selected folders.  

However the radio buttons let you select a subset of the files in each folder:

· All files: The default, as shown, which obviously displays all the files in both folders.

· Update from left: Displays files on the left which are (i) newer than those on the right, or (ii) are new
and have no corresponding file name on the right. 
This is useful for backing up the folder on the left, as it lists only those new/newer files that have not

already been saved in the folder on the right. 

· Matching name: The file names match, but the dates may or may not do so. 

· Identical: The file names and dates both match. 
Useful for identifying duplicated files that the user may wish to remove from one of the folder.

· Different: Displays all files which differ, i.e. everything except those where the file name and date
match. 
Useful for two-way synchronisation. 

· Left side only: Displays all files in the left folder. Files which are only found in the right folder are
omitted. 

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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In this way you have quick and simple – but very powerful – control over the synchronisation of folders.

A more fine-tuned method for selecting files can be accessed with the Advanced view.

           

The drop-down menu at the top can be used to select the subset of files to be displayed.  The checkboxes
indicate what groups of files will then be included in the grid following a refresh.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Subfolders

The Main tab in the central panel provides options for selecting particular classes of subfolders.

Ordinarily, by default, the contents of subfolders of the left and right selected folders will not be displayed:

However this may be overridden using the drop-down menu:

These options operate as follows:

None: Only files in the currently selected pair of folders will be examined.  No subfolders will be searched. 

All: All subfolders found in either the left or the right folder will be examined.  

Left side only: All subfolders found in the folder selected on the left hand side are examined.  Files in any
correspondingly named subfolders in the right will also be displayed, but otherwise subfolders on the
right are ignored.  Useful for backing up.

Matching: Subfolders will be displayed if there are subfolders having corresponding names on both sides.

Note that in these cases, and most especially the last, refreshing the grid may be slow (but the "Go" button
then becomes a "Cancel" button).

https://www.helpndoc.com/feature-tour


PickSync-help

29 / 70

When subfolders are to be examined, it is possible to limit the number of nested folders to be examined, by
checking the "Max depth" checkbox and selecting the maximum depth.

By default, there is a max depth of 2, meaning it will explore the current folder (depth 1) and its subfolders
(depth 2), but not any subfolders of its subfolders (which would be depth 3).

Otherwise, if this checkbox is unchecked, PickSync will recursively explore all subfolders to arbitrary depth:

(This may potentially involve a great many files and take considerable time - use with caution).

Folder and subfolder names are normally indicated in grey in the grid 

(unless selected, when they are highlighted).

If the "Maximum depth" checkbox is selected on the Main tab, 

and a subfolder at the maximum depth has still further and deeper subfolders, this will be indicated in the
grid in a pink information row.

This makes it faster to refresh the grid - but if you want to descend all the way, uncheck the max depth
checkbox!

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

File name filters

Ordinarily, PickSync will consider ALL filenames in a folder or subfolder being examined.

This can be changed by the File name filter box on the Main tab:

Its default value of "*.*" displays everything (all file names, all extensions).

This can be modified, so that e.g. 
  "*.txt" displays only text files.
  "Letter*.*" displays only files beginning with "Letter...".

In the conventional way, the asterisk '*' matches any sequence of characters, while '?' matches a single
character.  

https://www.helpndoc.com/feature-tour
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The text entered here is not case-sensitive (Windows considers that "abc.TXT" and "ABC.txt" are identical
file names).

When a limitation of this kind is in force, the file name filter box is coloured as a reminder:

Clicking the arrow to the right of this filter box displays a drop-down list of recently used terms, which can
be selected. 

Double-clicking the filter box restores its value to the default value of "*.*"

Tip: to list all files whose file names contain a given word or piece of text. just enter that word/text, without
using any '*' or '.' character.  The necessary wildcard characters will be added automatically.  

For example, enter "cat" in the File name filter box.  This will be expanded to "*cat*.*" and will list file names
such as "Catalog.txt" or "scatter.doc".

There is one other special case exception to the general rule that all file names are displayed:

On the 'Options" tab, there is a "Hide .wbk backups" option.  By default it is checked.

This means that backup files created by Microsoft Word (which it creates with a .wbk extension) will not be
displayed.  (The reason is that there tend to be a lot of them in working folders, they get in the way, and I
considered that backing up a mere backup is overkill).

There is also a more comprehensive set of filters available on the Filter tab. This can set upper and/or lower
bounds on file size or file date.
See the Filter tab topic below for details.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

Keyboard shortcuts

PickSync provides a number of keyboard shortcuts for common operations.

A list of them can be displayed from the Help menu. Further, the 'K' key is itself a keyboard shortcut for this
list:

https://www.helpndoc.com
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The function of these keys is as follows:

C (Copy) - Copy a selected file or files across the grid.

M (Move) - Move a selected file or file across the grid.

D (Delete) - Delete the selected file or files.  If a single row is selected and the row contains a file on both
sides of the grid, you will be prompted to indicate which of the two to delete (with a subsequent option to
delete the other one also).

O (Open) - Open the file (using the usual application associated with its file type), or (if it's a folder row)
open the folder in Windows Explorer. 

------

S (Search) - opens the Search tab, or if this is already open then carries out another search.

F (Find) - Find and move down to the next row (file or folder) not of the same type (folder or file) as the
current one.  Useful for examining long lists which are sparsely populated with items of interest.  
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< and > - Find the next unmatched row, on the left or on the right side (i.e. where the compare character is
< or > respectively).  Again, useful for long lists where there are only a very few items which may need to be
copied across.
The comma and full-stop keys have the same function as the < and > mnemonics (snce they are on the
same key on my keyboard), but there is no need to hold down the shift key.  (The shift key instead
searches upwards).

? - Find the next unmatched file (on either side), i.e. where the comparison character is either < or >.  In
short, find differences of any kind in the file lists displayed.  Once more, useful for long lists.

------

P (Picture Viewer) - open the Picture Viewer window, or close it if already open.

T (Thumbnails) - open the Thumbs (thumbnail) tab, or close it and return to the Main tab if already open.

I (Image) - Find and move down to the next image file in the list of displayed files.

U (Up image).  Move up to find the next image file.

------

Arrow keys - the left and right arrow keys <-- and --> will change the selected side, to the left and right
sides of the grid respectively.

A (All subfolders) - Selects all subfolders; or if already selected, then turns this off and selects no
subfolders.  In either case, it then refreshes the grid.

------

R (Refresh) - refresh (refill) the grid.  F5, the customary function key for refresh, has the same effect.

Q (Quit) - Cancels any pending filling of the grid.  The spacebar also has the same effect.

H (Help) - opens this help file.  F1, as is customary, has the same effect.

K (Keyboard help) - display the list of keyboard shortcuts, i.e. the list in the window depicted above.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Saving the file list

You can save the contents of the grid (the list of files being displayed) to a text file, in a number of different
formats.

(Note that this is not possible in Windows Explorer, and by itself represents a significant advantage of
PickSync over Explorer).

To do so, select "Save file list as a text file" in the File menu:

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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A dialog box will open, providing a number of options for the format of the saved file:

The available options are as follows:

· Which side of the grid to list: Choose to list either (a) files on the left side, or (b) files on the right
side, or (c) both sides merged together (blanks on teh selected side will be replaced by file details from
the unselected side), or (d) files on both sides together.  If this last option is selected, a tab character
will be inserted to separate files on the right-hand side).

· File properties: For each file present, (a) list just the file name, or (b) list the name, the date, and the
size (each element will be separated by a tab character).

· Include blank lines: If checked, any blank lines are included in the listing, exactly as they appear in
the grid.  Otherwise, any completely blank lines are ignored and not included.

· Include folder names: If checked, the folder names will also be listed.  Otherwise, only file names are
included in the text file.

· Selected rows only: If checked, only selected rows are saved.  Otherwise the entire content of the grid
is saved.

"Tab separated" means that the various entries on a line of text (if there is more than one entry for each line)
will be separated by a tab character.  Many word processors (including Microsoft Word) can then convert
such a file into a neatly formatted table.  (TIP: Open the .txt file in Microsoft Word, then select all rows and
click Insert | Table | Convert Text to Table).

Click "OK" to open a dialog box which enables you to select the file name.

Save options for the folder/file list

By default, PickSync will offer to save the list in the folder which contains the files being listed, but you can
change this.  

PickSync also suggests a default file name (created by taking the full path name of the folder, and replacing
backslashes with dashed).  Again, you can change this if you wish.  However the file extension must be
'.txt'.
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You can cancel the operation at any time and nothing will be changed.  Otherwise, click the 'Save' button to
create a text file, listing the contents of the grid in the chosen format.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Copying / Moving to another folder

PickSync's core functionality is to copy or move files across the grid, from the selected folder on one side to
that on the other side.

However it is sometimes useful to move a file or files somewhere else - to another folder entirely - without
having to change the selected folders.

The Copy To and Move To commands can do this. They can be accessed by right-clicking a selected file or
group of files.

Selecting one of these commands will open a form which lets you choose the target folder to which the
selected file(s) is/are to be copied or moved.

Choose the target (destination) folder and click OK.

Note that all selected files will be copied or moved to the same target folder (even if the selected files to be
transferred are in different subfolders).

https://www.helpndoc.com/help-authoring-tool
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After the transfer is complete, it is possible to have PickSync open the destination folder so that you can
review the result.  
This is done using the 'Open last CopyTo/MoveTo folder' option in the 'File' menu on the main menu strip: 

If a possible conflict arises, because the target folder already contains a file having the same name, then a
new form like this is presented:

Although complicated at first sight, it presents in one place every possible way that you may wish to handle
the conflict! 

The following options can be selected before the copy/move proceeds:

Cancel: If a conflict arises, the copy or move of the relevant file, and any other selected files, is cancelled.
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Skip: If a conflict arises, the relevant file is not copied or moved, but if any other files are selected then the
operation proceeds.

Overwrite: Any existing file in the target folder is overwritten, whether older or newer.

Append numeric suffixes: A suffix of the form "(01)", "(02)", etc. is added to the name of each conflicting
file being copied or moved.

"Skip" and "Overwrite" can be selected just for the present clash, or for all future clashes as well by
checking the checkbox.

Rename: As an alternative, there is an opportunity to rename the destination file manually, by entering a
new file name and clicking "Rename".  The text box allows you to enter a new file name (but not to change
the extension).  The source file name will not be changed, if you are copying, but that file will be given the
new name when it is copied to the target folder.  

New file names which still conflict will be rejected.  To help you to avoid other clashes, the file list at the
bottom of the form sets out the nearest existing file names.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Advanced view

You can switch between different versions of the 'Main' tab using the "Advanced View" option under the
'View' menu.

When selected, Advanced view looks like this:

The Main tab in the central panel provides options for selecting particular classes of matched and
unmatched files.

Ordinarily, by default, it will display all files in both folders.

https://www.helpndoc.com/feature-tour/iphone-website-generation
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The checkboxes below the drop-down menu (which you can ignore: you do not have to use them) indicate
this:

· Matching filenames will be displayed 

o whether they have the same date; or whether 

o the left or 

o the right side is newer.  

· Unmatched file names, both on

o the left and 

o the right side, will also be displayed.  

There are no other possibilities for the relationship between a pair of files, and so it follows that all files in
both folders are displayed by default.

However the drop-down menu permits selection of subsets of files, as shown below:

These different options are useful in different ways.  Thus :

· All files: The default, obviously displays all the files in both folders.

· Update from left: Displays files on the left which are (i) newer than those on the right, or (ii) are new
and have no corresponding file name on the right. This is useful for backing up the folder on the left, as it
lists only those new/newer files that have not already been saved in the folder on the right. 

· Unique in left: As the name suggests, lists files that do not have a corresponding file on the right. 
(These can be listed particularly quickly as no date/size comparisons need to be made across the grid).

· Unmatched: Lists files on either side which do not have a corresponding file on the opposite side. 
(Again, these can be listed quickly).

· Different: Displays all files which differ, i.e. everything except those where the file name and date
match. Useful for two-way synchronisation. 

· Matching name: The file names match, but the dates may or may not do so. 

· Identical: The file names and dates both match. Useful for identifying duplicated files that the user may
wish to remove from one of the folder.

· Left side only: Displays all files in the left folder. Files which are only found in the right folder are
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omitted. 

· Folder names only: Displays no file names at all, but if subfolders are selected then subfolder names
will be listed.

The drop-down menu allows very rapid selection of what file names will be displayed in the grid. In turn this
makes it very easy to select groups of individual files for copying or moving. (In the ideal case simply “Select
all”, as the grid will only be displaying those files with the characteristic of interest).

In this way the user has quick and simple – but very powerful – control over the synchronisation of folders.

You can experiment by selecting different dropdown options, and noting which of the checkboxes
underneath are checked.

In addition, you may check or uncheck the checkboxes manually, in which case the drop-down menu will
indicate a "custom" selection.

Finally, note that the "Size overrides date" checkbox in the Main tab makes some adjustment to the
above.  

      

If checked, comparisons between files are now on the basis of size rather than date:
So the checkbox labels will be: rather than:

The comparison character in the grid will also now be based upon this different kind of comparison.
Be careful - a larger file does not necessarily indicate a newer one!

Created with the Personal Edition of HelpNDoc: Free help authoring environment

The central panel

The central panel is used to control the majority of PickSync's features.  It looks like this:

https://www.helpndoc.com/help-authoring-tool
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Along the top, it provides the following tabs:

· Main - As shown above.  The most important and commonly needed functions are controlled here.

· Filters - For special selection of files to be displayed.

· Report - Contains details of the last time the grid was refreshed.

· Options - For selection of program options.

· Search - For searching for particular files within the grid

· Thumbs (thumbnails) - displays small versions of image files.

Each is described on a separate page below.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Main tab

The Main tab looks like this:

The principal functions of PickSync are controlled here.

The "Files" selection and "Size overrides date" checkbox are explained in "Matched and unmatched
files".

The "Subfolders" selection is explained in "Subfolders".

The "File name filter" is explained in "File name filters", and the "More filters" checkbox is explained in
"Filter tab".

https://www.helpndoc.com/help-authoring-tool
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A more fine-tuned method for selecting files can be accessed with the Advanced view.  (See the separate
page describing it).

The "REFRESH" button refreshes the list of files displayed in the grid.  

Note that in general:

· The grid is not automatically refreshed when the files contained in a selected folder change (because
this could be very annoying).

· The grid is not automatically refreshed when a selected folder changes (it can be annoying if it does, for
instance when you first need to change the other folder).

But when a selected folder changes, the "REFRESH" button turns pink to indicate that a refresh is required.

This is not an error condition, but simply a warning that the grid contents may no longer be displaying files
that match your current choice of selected folders or other filters.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Filters tab

The Filters tab looks like this:

It is used for special selection of files to be displayed.  Lower and/or upper limits can be set for the file SIZE
or the file DATE.

There is a separate checkbox associated with the lower and the upper limit for each of these properties.

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle


PickSync-help

41 / 70

Note that these filters are only operative while this tab is being displayed.

File SIZE limits

The "More than" and "Less than" limits are only applied if their corresponding checkboxes are checked.

File sizes may be entered as an exact number of bytes.  

In addition, the suffixes 'b', 'k', 'M', or 'G' may be used here.
- 'b' stands for bytes (it is not necessary to specify the 'b'),
- 'k' or 'kb' is kilobytes meaning 1024 bytes, 
- 'M' or 'Mb' is megabytes meaning 1024 kb which is 1,048,576 bytes, and
- 'G' or 'Gb' is gigabytes meaning 1024 Mb which is 1,073,741,824 bytes.

So you can enter 54, 54b, 54k, 54kb, 54M, 54Mb, etc.  Bytes is the default.

File DATE limits

Again, the "From" and "Up to" limits are only applied if their corresponding checkboxes are checked.

The date may be entered as text, or by using the button on the right to see a drop-down calendar:

The drop-down calendar lets you click on a selected date, and also has an option to select today's date:

Selection of a date includes any time of day on that date.  So, for example, setting both "From" and "Up to"
to the same date will include all files on that date - from midnight on the morning of that day, right up to the
last moment before midnight on that night.

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator

Report tab

The Report tab looks like this:

https://www.helpndoc.com
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It contains details of the last time the grid was refreshed.

During a refresh operation, this tab will be displayed and will indicate progress.  The button at the bottom
becomes a "Cancel" button: this may be particularly useful if an unexpectedly large number of subfolders is
encountered.

In any event, the information on the Report tab is preserved and may be reviewed at any time up until the
next refresh of the grid.

The information displayed is as follows:

File rows Entered: Self-descriptive.  It will equal the total number of rows in the grid, less those used for
folder names (grey) and for information (pink).  Each row may contain one or two file names.

Files Considered: The number of files reviewed during the refresh operation.  Some may be excluded
because they did not meet the file name filter or filter tab requirements.  This value may be more than the
number of file rows, because a single file row may contain two separate files.

Folder pairs explored: Will be more than one if subfolders are being displayed.

Time started, Time ended: taken from your computer's clock, to the nearest millisecond.

Total time taken: The total time taken to refresh and refill the grid, to the nearest millisecond.  Obviously it
depends on the speed of your processor and of your storage.  It also depends on the number of files
examined, which in turn depends on the choice of subfolders being examined.  If it is taking too long, note
that the button becomes a "Cancel" button during the refresh operation.

Total files on each side: the number of file rows on each side of the grid.

[bytes]: The total number of bytes (displayed file sizes) of all files on each side of the grid.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Options tab

The Options tab looks like this (showing the default settings/values):

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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This tab allows you to select program options.

The "Confirm" section provides a number of checkboxes.  If checked, PickSync will request express
confirmation before carrying out the specified operations.
You may wish to uncheck the "Confirm Copies", "Confirm Moves", and "Confirm New Folders", since in
none of these operations can copies/versions of files be lost.
But you may wish to be more cautious before unchecking "Confirm Overwrites" and "Confirm Deletes" -
these operations can change file contents (though note that deleted files are by default placed in the
Recycle bin if possible and can be recovered from there if necessary).

Note: The options "Confirm Deletes" and "Confirm Multi(ple) Deletes" are presently set by default and
cannot be unchecked.

File number limit sets the maximum number of file rows that will be displayed in the grid.  If that limit is
reached during a grid refresh, an information row will be displayed at the end of the grid:  

This value for the limit can be increased - its purpose is to prevent grid refresh taking too long.

Ignore 1 hour differences: is checked by default.  This option is present because of a quirk in Windows. 
The modern NTFS file system and the older FAT file system (often used on USB sticks) store file dates in
different ways, and in particular handle summer time differently.  (FAT only saves file times to the nearest
two seconds, while NTFS allows for timezones and for summer/winter time and saves times to within a
fraction of a second).  
One consequence is sometimes that files that appeared to be identical in summer may seem to have file
times differing by an hour when compared in winter. or vice versa.  This can be confusing.
If this box is checked, then files whose dates/times differ by exactly an hour, plus or minus two seconds,
are treated as identical.  

Hide .wbk backups is explained in the File name filters page.  In brief, the extension ".wbk" is used by
Microsoft Word for its backups.  By default, these files are not displayed - it is usually overkill to back up
these backups as well as the principal ".doc" files.

Hide system files: if checked, the following system files and folders will be omitted from (not displayed in)
the grid:

· desktop.ini

· thumbs.db

· $Recycle.bin

· System Volume Information
The first two files are only relevant to the particular folder in which the system created them, and should
generally not be copied or moved elsewhere.  The others are system folders used by Windows and should
not ordinarily be modified. 

Omit subfolders with no content to show: Sometimes a folder may contain a large number of empty
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subfolders (or subfolders containing only files that are not to be displayed, depending on which filters you
have set).  Check this box to stop these folder names being listed: the grid will then contain only file names,
and names of folders which contain at least one displayed file.  (Note that in this case, the "Remove empty
folders" command (see the main menu strip) will not have any effect, since no empty folders will be
displayed).

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Search tab

The Search tab looks like this:

This tab can be used for searching for particular files within the grid.

Filename to seek: Enter a filename, or a part of a filename, here.  The drop-down box allows repetition of
previous search terms.

Match filename how: Provides three alternative match options:

· Match at start: the beginning of the filename must match the search text.

· Match anywhere: any part of the filename may match the search text.  Useful e.g. for file extensions:
search for ".txt" to find text files.

· Find nearest name: Even if there is no exact match, this will find the file name which is alphabetically
nearest but just below the search text.  Like looking up the search text in a dictionary and finding the
nearest entry.

Search options are:

· Include foldernames: If checked, searching will look for the searched text in either folder names or file
names: otherwise it will only look in file names. 

· Skip neighbouring matches: this makes the search ignore any further matches immediately after the
current row, in a "cluster" of matches.  If checked, search will move down to at least one non-matching
file before again seeking a match.

· Search Selected Side only : If checked, searching will ignore the unselected side of the grid.

· Case sensitive:  If checked, will require upper or lower case to match; by default, case is ignored.

The "Search" button, obviously, carries out a search.  You can hit "Return" to carry out another.

Holding down the Shift key when you click the Search button will search upwardly in the grid.

Created with the Personal Edition of HelpNDoc: iPhone web sites made easy

Thumbs (thumbnail) tab

The Thumbs (thumbnails) tab displays small versions of image files.  It looks like this:

https://www.helpndoc.com/help-authoring-tool
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It can be selected by 

· Clicking the 'Thumbs' tab header, or 

· Right-clicking an image file in the grid, and choosing the 'Thumbnail' option; or

· Using the keyboard shortcut 'T'.

If the selected row contains an image file (or pair of files), then a small thumbnail of the image(s) on the left
and/or right side will be shown.

Double-clicking a thumbnail image will open a larger copy in a separate Picture Viewer window.

If the 'update continuously' checkbox is checked, then every time the selected row changes, the
thumbnails will be updated to match the new row. 
 
However this may slow down performance when changing rows (depending on your computer's speed and
the size of your images).  If it does, try unchecking the box.  (Or select a different tab: this slowing can only
happen when the Thumbs tab is open).

For further details of supported image files, and an explanation of use of the Picture Viewer form to display
images in a larger size, see Images and Pictures.

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

The main menu strip

The main menu strip at the top left of the program window has submenus for File, View, Tools, and Help, in
the conventional way.

The functions available are described below.

The File menu

https://www.helpndoc.com/feature-tour/iphone-website-generation
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Save file list as a text file: See Saving the file list

Open last Copy To / Move To folder: This will open in Windows Explorer the folder which you last used as
the target of a Copy To or Move To operation.  This is convenient for checking that the operation
succeeded.

Exit: This closes PickSync.  Your list of Favourite folder pairs will be saved (if "Safe Mode" is on, you will
first be prompted to confirm this).

The Edit menu

Select All Files: Select every file currently displayed in the grid, on the selected side.

Select Files in Current Folder: When subfolders are being searched, allows selection of all the files in the
same subfolder as the currently focused file.

Swap Left/Right Folders: Exchange the left and right folders as currently displayed in the grid.

Copy Across / Move Across: This is one of several ways of initiating a copy or move of the selected files
from one side of the grid to the other.  See Copying and Moving files.

Delete: Deletes the selected file or files.  See Deleting files. 

The View menu
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Advanced View: Toggle between alternative versions of the 'Main' tab.   See Advanced View.

Repeat last message: Many of PickSync's progress messages are displayed briefly for a few seconds,
and then quietly get out of the way and disappear by themselves (no need to keep clicking "ok").  This
command redisplays the most recent ones again, in case you missed them or want to review them once
more.  You can also use the "R" keyboard command.

Show the Picture Viewer: This opens the Picture Viewer form.

The Tools menu

Search: Opens the Search tab in the central panel.

Options: Opens the Options tab in the central panel.

Safe Mode: Toggles on or off Safe Mode.

Lock Folders: If checked, causes the right folder to track that on the left.  If a subfolder of the left-hand tree
is selected, and there exists a subfolder with a corresponding name on the right, then the right-hand
one will be selected at the same time.  This helps with quick exploration of two sets of folders with
matching subfolder trees.

Remove Empty Subfolders: When subfolders are being displayed, this function will examine each
subfolder listed in the grid on the selected side (left or right, as chosen in this menu), and deletes
any that are empty.  (Yes, it removes any empty sub-sub-folders first).  This is useful for cleaning
up, if files have been moved out of a number of subfolders.  Please use with caution as, while very
useful, this is the only feature of PickSync that can delete folders (albeit only empty ones), and it
deletes them permanently rather than to the Recycle bin.

The Help menu
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Help: brings you here, to this Help file.  If you are reading this, you have probably found this menu already.  

Help - keyboard commands: see here for more details.

Registration: Opens the Registration window.

Send suggestion: Offers to draft an email with addressee (picksync@outlook.com) and subject lines pre-
filled, in which you can add any suggestions or bug reports about the program.

Visit Website: Uses your web browser to open the PickSync website home page at
http://PickSync.wordpress.com.

View Readme, View Licence/Disclaimer: Display the Readme.txt and Licence.txt files. Please review
them.  Note that you accepted the licence when you installed PickSync.  Its text is also here.

About: As is customary, identifies the version and states other details of the program which you are
running.

Created with the Personal Edition of HelpNDoc: Free CHM Help documentation generator

The top row buttons

The buttons on the top row

There are three groups of buttons at the top of the main window, just below the main menu:

The "Select All" button will select every row in the grid.

The "Select Folder" button will select every file which is in the same folder as the currently selected row.

The "Faves" button, standing for 'Fave (favourite) Folders', accesses a separate form allowing the saving and
re-selection of your most-used pairs of folders.

http://picksync.wordpress.com/
https://www.helpndoc.com
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The 'Copy Across' and 'Move Across' buttons will perform a Copy or a Move operation from a folder on one
side of the grid to that on the other side, as described on the "Copying and Moving Files" page.

The 'Safe' button, located at the top right of the main window, toggles Safe Mode on or off.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

The status bar

At the bottom of the main window is the Status bar, indicating the full path and file name of the currently
focused file:

Right-clicking a file or folder name in the status bar will bring up a menu showing further possible operations:

Rename brings up the standard rename dialogue.

Copy ... to Clipboard: Several sub-options are provided to copy the file name and/or path to the clipboard.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Right-click menus

When a file row is right-clicked, the options available may include some or all of the following:

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Options that are not applicable (e.g. 'Picture Viewer window' when the row is not an image file) will be
greyed out, and so cannot be selected.

Open: Opens the selected file in the application which you usually use for it: e.g a .doc file will be opened in
your word processor, an .mp3 file in your mp3 player, and so forth.

Open With: Choose the application with which to open the file.

Copy: Copies the selected file or files to the folder on the other side of the grid.  See Copying and Moving
files.

Move: Similarly, moves the file(s) to the folder on the other side of the grid.  See Copying and Moving files.

Open Container: Opens in Windows explorer the folder which contains the file.

Copy To: Copies the selected file or files to another folder (which need not be the other folder in the grid). 
This option opens a dialogue box allowing selection of the target folder.  See Copying and Moving to
another folder.

Move To: Similar to Copy To, but performs a move rather than a copy.

Rename: Allows you to Rename the file (and optionally, similarly to rename any matching file on the other
side of the grid).  IF more than one file is selected, you can rename all of them by adding a common
prefix or suffix, or replacing a phrase within the file name with another.

Copy Name to Clipboard: Several sub-options are provided to copy the file name and/or path to the
clipboard.

Properties: Displays the file's properties, as known to Windows.

Picture Viewer window: Opens a new form to display an image.  See Images and Pictures.

Thumbnails: Opens the Thumbs (thumbnail) tab to display a small version of the image.  See Thumbs
(thumbnail) tab.

Delete: Deletes the selected file.  See Deleting a file.
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When a folder row is clicked, many of these options are no longer applicable, but there are two folder-
specific further ones:

Up one level: See illustration below.  If the selected folder row is the first, topmost, row in the grid, then
this option will select two new folders in the grid which are the parents of the current selected
folders. 

Down a level: See illustration below.  If the selected folder row is anything other the first, topmost, row in
the grid, then this option will select two new folders in the grid which are the folders in this selected
row. 

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

Rename

You can rename a file by right-clicking it and selecting the 'Rename' option.

This brings up the Rename dialog box:

You can now enter a new file name.  Provided that the new name does not conflict with another existing file
name (this will be checked!), the file will be renamed. If there was a problem, you are given the option to
retry or cancel.

https://www.helpndoc.com/feature-tour
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The file extension (here, .jpg) is normally protected - Windows uses it to identify the type of the file, and so
you should not normally alter it.

However, if you really want to change it and you are sure you know what you are doing, then double-click
this field.  PickSync will then allow you to enter a new extension.

Renaming a matching pair of files

If there is a file with a matching name on the other side of the grid, then you will be offered the option of
renaming that file too, to the same new file name:

You can then rename the file on both sides, or only on the selected (highlighted) side, just as you wish.

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Renaming groups of files

If more than one file is selected, then you can rename them all simultaneously.  (Note: as an incentive to
register and a thank-you, this feature is only available to registered users).

Right-click the selected group of files and select "Rename Multi..." in the menu that appears:  

This will open the Multiple Rename window:

https://www.helpndoc.com/help-authoring-tool
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Four options are offered in the left of the window: you can add a common prefix or suffix to all the selected
files, you can replace a phrase in the file name with another, or you can select from some known
replacement presets, e.g. to replace underscore characters with spaces.

Try it! - select a group of photos which were taken at the same time, and add a meaningful prefix or suffix to
them all at once, to describe what is shown.

While other special-purpose renaming programs may offer more options, these suffice for the vast majority of
instances where renaming is needed.  Moreover, PickSync makes it possible to rename both copies of a file
at the same time, in the same way.  Rename both your main and backup copies, at any time after the
backup has been made.

As with all other operations in PickSync, if you want to see what will happen, but without actually altering
any of your files, select Safe Mode - then the multiple rename operations will merely be simulated so that
you can make sure that the result would be what you expect.

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

Images and the Picture Viewer

PickSync offers particular facilities for viewing and handling image files as follows:

· Thumbnails of image files can be displayed in the 'Thumbs' tab.

· A separate 'Picture Viewer' window can display an image.

Image files can therefore be reviewed as they are copied or moved.  This makes PickSync especially useful
for copying or moving selected images from a camera to a folder on a PC, and thereafter for copying them
from there to a USB stick/drive or elsewhere.

Images recognised by PickSync may be of the following types:

· .jpg; .jpeg; .gif; .tif; .tiff; .png; .bmp (bitmap); .ico (icon); .emf; .wmf

The thumbnail tab and picture viewer window can display animated .gif files.

The  'Thumbs' tab, illustrated below, has its own explanatory page.  If the selected row contains an image
file (or pair of files), then a small thumbnail of the image(s) on the left and/or right side will be shown.

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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Picture Viewer window

PickSync can also open a separate Picture Viewer window to display image files.  Unlike the thumbnails,
this can be resized and enlarged up to the size of your display screen.  (But for unregistered copies, there is
a nominal maximum size - this limit is removed following registration).

The Picture Viewer can be opened by 

· using the right-click menu in the grid; or

· using the keyboard shortcut 'P', or

· Using the View | Show Picture Viewer option in the main dropdown menu; or

· Double-clicking a thumbnail image in the 'Thumbs' tab.

Once it is open, changing the selected row in the main PickSync window will change the displayed image in
the separate Picture Viewer.
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This window displays the image file on the selected side of the grid, and can be resized or maximised in the
usual way.

Click on the Picture Viewer window and then use the mouse wheel to scroll up and down through any
images listed in the grid in the main window.  Non-image files are skipped over.

Click the Zoom In/Out button  to toggle the image size between different available
zoom levels, including zoomed by a fixed multiple or shrunk/enlarged to fit the window. (Registered copies
only).
The + and - keys on the keyboard will also change the zoom level.

When zoomed, i.e. showing , hold the mouse button down on the image while moving
the mouse to pan around the image. 

Picture Viewer window - keyboard shortcuts

A list of the available shortcut keys can be obtained using the 'K' keyboard shortcut:
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The descriptions speak for themselves.  Note that, so far as possible, these match corresponding keyboard
shortcuts in the main PickSync window.

Picture Viewer - right-click menus

Right-clicking the image in the Picture Viewer window provides a menu of possible actions:

Zoom - change zoom leval: will toggle the image size between full size, or shrunk/enlarged to fit the
window.

Open image in external viewer: will open the image in whatever application you normally use to view
image files of that type.

Open containing folder: will open the folder containing the image, in Windows Explorer.

Closing the Picture Viewer

The Picture Viewer can be closed:

· In the usual way to close a Window, clicking the red-boxed 'X' at the top right ;
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· More quickly, by double-clicking the image;

· Right-clicking the image and choosing "Close this Picture Viewer", or

· Using the keyboard shortcut 'P', which will close the Picture Viewer window if it is already open.

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Command line operation (Advanced)

If PickSync is started using the command line, it is possible to add parameters to set the folders and file
filters applied when it first starts up.

First two parameters - folder names

If present, the first one or two parameters will set the folders on the left and/or both sides.

Hint: it is a good idea to enclose folder names in inverted commas.  This is necessary if the folder name
contains a space character.

Examples:

Command line Result

PickSync Start the program.  The left and right folders will be set using the first entry in
the Faves table if there is one, otherwise default folders will be used.

PickSync "C:\abc" Start the program.  The left folder will be set to C:\abc, the right folder will be
a default folder.

PickSync "C:\abc"  "D:
\new folder" 

Start the program.  The left folder will be set to C:\abc, the right folder will be
set to 'D:\new folder'

Third and subsequent parameters - other initial settings 

It is also possible to use the third and subsequent parameters to initialise other settings as follows:

Parameter Result

  -fi Followed by a digit (0-9), sets the "Files displayed" dropdown, counting from zero.  E.g. -fi3
sets it to the fourth entry down (which is "Changed").

  -fo Followed by a digit (0-3), sets the "Subfolders viewed" dropdown, counting from zero.  E.g. -
fo1 sets it to the second entry down ("All").

  -fn Followed by a text string (no spaces, up to 16 characters), sets the "File name filter" entry. 
E.g.-fnc*.* sets it to "c*.*"

  -de Followed by a digit (0-9), sets the Subfolder maximum depth.  E.g. -de3 sets it to a
maximum of 3 (a folder, its subfolders, their sub-sub-folders).  '0' indicates no limit.

  -so Sets the "Size overrides date" checkbox,

  -to Set the File date filter (on or after) to today only.  Can also be followed by a minus-sign and
a digit: "-to-#" will set to include up to # days before today, where # is a digit from 0 to 9.

  -nf [= No Fill] - don't fill (‘refreshʼ) the grid content when starting up

  -- or // Ignore any subsequent remaining arguments, treat as commented out

Example:
PickSync "C:\abc"  "D:\new folder" -fi5 -to-3 

will start the program, with the two given starting folders, showing Unmatched files created today or in the
last 3 days before today.

https://www.helpndoc.com/help-authoring-tool


PickSync-help

58 / 70

Created with the Personal Edition of HelpNDoc: Free help authoring tool

Installation and Uninstallation

Installation is simplicity itself.  Download the setup file, PickSync-setup-[date].exe, run it, and follow the
simple on-screen instructions.

You can safely install the latest setup program over an existing earlier version - all settings, favourite folder
pairs, and registration details will be preserved.

There is of course an uninstaller, which will completely remove PickSync from your system.
You can find it in your Start menu, under the PickSync program group:

I hope you won't, but you may feel happier when installing PickSync to know that you could uninstall it
again if you had to.

Technical note regarding installation files

When installing a new application, I like to know what it does to my computer – the extent to which I trust it
depends in part on how much detail is provided. So it therefore seems only fair to be candid here. 

The PickSync setup program was created using "Inno Setup", a long-established and very widely respected
installation builder. Inno Setup also provides an uninstaller, which does a splendid job of removing
everything that it originally installed. Though I hope you never need it, knowing that the uninstaller will be
there should give you the confidence to install the program in the first place. 

The setup program does the following:

· It creates a new subfolder, ...\PickSync, in your Windows Program files folder (usually C:\Program
Files\). Into this it places: 

· PickSync.exe, the application itself. 

· PickSync.chm, this Help file. 

· PickSync-licence.txt andPickSync-readme.txt, self-explanatory text files. 

· ShellBrowser.dll, a utility needed to generate and manage the left and right folder trees. 

· unins000.exe and unins000.dat, the uninstaller files.

· It creates a data folder, PickSync\, in your application data folder (usually C:\Users\[username]
\AppData\Roaming\). 

· PickSync.ini is created here. It stores details of your preferences (in particular your list of
Favourite folder pairs, and is updated and backed up to a filePickSync .ini.bak.when the
program is closed.

· It creates a program group, "PickSync", in your Windows Start menu, which contains 

· A link to the program itself, and 

· A link to the uninstaller.

· Finally, it may create a link on your desktop and/or a quick launch icon: these are options offered
during setup.

All of the above are removed if PickSync is uninstalled. So please install it with confidence.

https://www.helpndoc.com/help-authoring-tool
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Registration and Expiry

PickSync has a facility to Register the program with its author.  There are several reasons for this:

· Although the beta version is currently available free and without charge, I would like to be aware of who
is using it - how many people - and establish some contact so that I can get much-wanted feedback.

· One day I may use some agency to sell it for some reasonable sum.  Because it's worth it!  Before
then, I would like to test the registration system.

Registration is not compulsory.  All of the features of the program work on an unregistered version.  

However there are some "nag" messages that are generated from time to time (usually during an operation
that works on multiple files at once).

I do appreciate that such 'nag' messages can be mildly annoying.  Of course, that is their point!  If you don't
like these messages, just register - at the moment it's free.  If you don't want to register, that's fine too but
an occasional nag message is surely worth tolerating in return for all the free functionality you are getting.

Expiry

Whether or not the program is registered, each beta version has an expiry date.  Following expiry, it will
work only in Safe mode.  

https://www.helpndoc.com/help-authoring-tool
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Why?  The program is still in development and I do not want seriously outdated versions to be still in use out
in the wild.  Expiry protects everybody.  I will remove the expiry limitation once I am satisfied that the
program is sufficiently mature for general use.  Your feedback will help accelerate this!

The Picksync website will always have an unexpired and up-to-date copy available. You can install this over
an existing earlier version - all settings, favourite folder pairs, and registration details will be preserved.

How To Register

The registration form, which can be opened using ''Help' | 'Registration', looks like this:

http://picksync.wordpress.com
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To obtain a registration code, click the big button at the bottom.  PickSync will:

· Tell you that you need to send an email setting out your full personal name, to picksync@outlook.com,
and

· Offer to draft it for you, using your email program.  

If you are happy to let it do this (I know of no reason why you should not be), fill in your full personal name
and click "Send".
I will respond with an email containing a code as soon as I reasonably can.

To use the registration code: Open the registration form (see ''Help' | 'Registration').  

· Then, from the registration email which you have received, cut the six-line code which comprises your
name, email, and four lines of incomprehensible characters.  

· Paste the six-line code in its entirety into the space provided on the registration form.  

· Click the big "Paste ... then click here" button in the middle.

That's it!  Once registered, you stay registered and your registration code is saved.  
Thank you for registering.  Now that we have made contact with each other, I would also be pleased to
receive any suggestions or comments which you may have - see "Help | Send Suggestion".

Created with the Personal Edition of HelpNDoc: Free EBook and documentation generator

Changelog

A history of detailed changes in recent releases
(starting in 2015 as a nominal baseline: the earliest build (not released publicly) was in 1996):

Version 17.10 (2017 Oct 01)

· Deletion of a folder is enabled, but only if the folder is empty (no files or subfolders)

· Dragging a file name out of the grid is enabled – which permits file or filename copying, but not moving
the file away

· Renaming - Rename form default button is selected side only (rather than both sides) if the file names on
each side are the same but the files themselves are different 

· Renaming - Double-clicking upper textbox in the Rename Multi form repeats the most recent entries

· Copying or moving a file - if there is a file name conflict where the file name already exists in the target
folder, there is now a clearer indication of which of source or target file is "Newer" or "Bigger"

mailto:picksync@outlook.com?subject=PickSync -    ... [please be more specific here...!]
https://www.helpndoc.com
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· Remove Empty Subfolders - always show the folder in the visible area of the grid when offering to remove
it 

· New Command line parameter "-nf" [= No Fill] - don't fill (‘refreshʼ) the grid content when starting up

· New Command line parameters "--" or "//" mean ignore remaining arguments, treat as commented out

· Bugfix – "Select All" button no longer includes information rows

· Bugfix – Correct behaviour when picturebox is minimised while in Zoomed mode

· ShellBrowser component has been updated to most current version 5.40

· Many minor UI tweaks and enhancements, code simplifications and polish

Version 16.09 (2016 Sep 30)

Minor bugfixes and UI polish: including

· Picture viewer window will retain zoom level from the previous image

· Status bar will show name of file on the unselected side, if the row on the selected side is empty

· If renaming a file fails and the user retries, the (failed) new name is shown again so that the user can fix
it

· During a multiple copy, move, or delete, if one file fails the user can choose to proceed with the rest 

· Bugfix - warn if unable to save data to clipboard because clipboard blocked by a third party program

2016 Jan 01

· New keyboard shortcut ‘\ʼ or ‘|ʼ : Find next row with matching names, but different size/date properties

· Copy To / Move To form now has a dropdown menu to select previously used folders

· View | Show previous messages will now show several previous ones, not just the very last one

· Navigation characters < and > (find next file to copy) can also be used within the Picture viewer

· Picture viewer window - keyboard + and - will change zoom level (registered users only)

· Picture viewer window - bugfix - ignore left/right arrows if in single column mode

· File filter - bugfix - no longer highlighted when doesn't have keyboard focus

· Thumbs tab - bugfix - clear the right-hand thumbnail if in single column mode

· Double-clicking the file filter to reset to "*.*" will also immediately refill the grid

· Fix to address nomenclature changes in Windows 10

2015 Dec 01

· Interim release to update expiry date pending January 2016 release

2015 May 04

· Searching – Added new search option – search in the selected side only

· Searching – drop the “search from top” option as unnecessary

· Searching – Search always places found row in visible portion of grid

· Rename multi - ensures each file row is visible – and shows in picbox if open - as it is renamed 
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· Rename multi – now will not apply any text-replace rule to the file extension

· Rename multi - now offers chance to retry with different rule after error

· Rename multi –now preserves different upper/lower case on each side case to the extent possible
when not replacing it

· Rename multi - Ensure status strip will update after rename

· CopyTo/MoveTo form - separate last-recent-used folders for left and right side of grid

· Picture viewer window - Selectable zoom levels when registered

· Picture viewer window – Fixed crash if .gif file was misnamed as .jpg 

· Picture viewer window – Close quickly with Esc key (“Boss Key”)

· File Name Filter - Donʼt match 8.3 filenames (workaround Windows annoyance/ issue)

· Can now drop folders into areas of grid below the list of files if that list does not take up the whole area

· Ctrl-home, Ctrl-end  move focus & selected to first / last entry in grid

· Warn if folder listed in grid has ceased to exist (e.g. usb drive removed, folder renamed)

· Updated Shellbrowser.net component to latest version 5.2.1

2015 Jan 01

Baseline release

Created with the Personal Edition of HelpNDoc: Easily create PDF Help documents

FAQ and problems

FAQ (Frequently* Asked Questions)

· I really like your program, how can I pay for it?

Donʼt worry, that facility is coming soon…

Do please feel free to make an optional donation - see the website at 
http://picksync.wordpress.com/feedback/ 

· May I see the source code?

No. Unless you would like to buy the copyright in it outright. But I̓ ve worked long and hard on it and I
ainʼt cheap.

* (allegedly… :-)

Known limitations

There are currently some minor limitations which it may be possible to address in future releases:

· No Homegroup in Windows 7: the tree component (which I have incorporated under licence) does not
recognise the Windows 7 'Homegroup' folder, which is therefore not shown in the folder trees.

· No iPhone folder in the folder trees.  Similarly, limitations in one or more of the tree component,
Windows 7, and/or Apple's closed hardware means that the contents of an iPhone cannot be viewed in
PickSync.  I am particularly keen to find a way around this, but presently can't.

https://www.helpndoc.com/feature-tour
http://picksync.wordpress.com/feedback/
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These are isolated issues: I would add that my home network, and my Sony camera, are both fully
compatible with PickSync.  I would be grateful to be told about any other network or device that is not
accessible. 

Errors and bug reports

I hope that none will arise.  However, out of a superabundance of caution, PickSync does proactively check
for, and trap/rectify, potentially erroneous conditions.  

If an error does arise, the program will also issue a warning message and will draft an email to me setting
out details.  Please send it, and supply any other information about what you were doing at the time which
may help me to prevent any future recurrence of the problem (a screenshot may be especially helpful if you
can provide one).  Thank you!

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Contacts: Website and email

The PickSync website is at http://picksync.wordpress.com

You can contact me by email at picksync@outlook.com

If you click on 'Help | Send suggestion...', PickSync will open a dialogue box as shown below.  
If you then click Yes, it will prepare a draft email with the address and subect lines prefilled, and you can
then add any comments before you send it.

If you don't want PickSync to do this, or if it is unable to access any email program, it will offer to open a
form on the PickSync website instead, where you can leave your comments:

PickSync never "phones home" by itself - it never connects to the internet and it neither sends nor

https://www.helpndoc.com/help-authoring-tool
http://picksync.wordpress.com
mailto:picksync@outlook.com?subject=PickSync -    ... [please be more specific here...!]
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receives any internet traffic.
(I think this is important, but a downside is that there is therefore no "Automatic Update" - should there be?)

PickSync will offer to draft emails for you to send to me:

· When you click Help|Send suggestion, and then click OK, or 

· When you request a registration code, or

· When (if ever) an internal error condition arises.

In any such case, 

· it will only draft the email if you first click the 'Yes' button to request this, and

· it will not itself send the email - you must yourself click "Send" in your own email program to do so.

As shown below, an email message will be drafted (and so an offer to access your email program will be
made) only if you first click 'Yes'.  PickSync will NEVER do so without your knowledge and your express
consent.

Moreover, PickSync does not itself send the email - you the user will have to ensure that you have an
internet connection, and you yourself must click the "Send" button in your email program.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

Licence and disclaimer

PickSync Licence and Disclaimer:

You may use this software subject to your accepting the terms below 
(in summary, there is ABSOLUTELY NO WARRANTY WHATEVER).  They are 
not onerous or unfair - I use the program myself on exactly the same terms!

-----

PickSync is designed with the aim of handling data as safely as it can. 
It has been carefully tested - I have used successive versions for 
my own data (including constantly saving and moving its own source 
code) on a daily basis for many years, literally thousands of times.

However, it is a powerful tool, and like any tool, it can be misused. 

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Its reliability also obviously depends on the correct operation of your 
hardware (in particular your disk drive) and your Windows installation.

Please enjoy, and use it with care: but I cannot accept responsibility for 
any data loss or for any consequence however serious and/or however caused.

I cannot know how you will use this software, or what data you will use 
with it. Further, if any data is lost, it will be impossible to tell 
after the event whether this was due to a fault in the program, or to 
user error, or to a fault in your hardware or in your Windows installation.

For all these reasons, although I have of course tried to be very careful, 
there is ABSOLUTELY NO WARRANTY WHATEVER!

-----

Therefore, in the words of so many other licence agreements:

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF 
ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED 
TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT 
SHALL THE AUTHOR BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT 
OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH 
THE SOFTWARE OR USE OF OR OTHER DEALINGS IN THE SOFTWARE.

-----

Please also note that this copy will EXPIRE after 31 December 2018, 
after which it will only operate in 'Safe Mode' - see the Help file. 
A new version will be made available on the website before then. 

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

History of PickSync

The two-column concept in PickSync was loosely inspired by an old MS-DOS text-only program called
DIRMATCH.COM which I used in the 1980s on 5¼" floppy disks.  Sadly, Dirmatch was never upgraded into
a Windows version.

So I wrote the first version of PickSync for my own use in 1996 (see screenshot below).  The key section of
code for selectively traversing folders and files was first drafted with pencil and paper on a beach during a
family holiday, and successfully tested on my return. 

I have been using successive versions on a daily basis ever since.  Indeed, when I work on the program, I
use it repeatedly to back up its own source code (and likewise this help file).  I know of no better tool for this
and doubt if there could ever be one!

As the program became more and more useful to me, I continued to add features that I found convenient.  

· First, as I was using it often and with several different source and target folders, I added the "Fave
Folders" button. 

· For finding particular files, the 'Search' feature was added.  This was conveniently situated in a
separate tab in the central panel.  

· Once the central tabbed design was established, 'Filter', 'Report', 'Options', and 'Thumbs' tabs
followed, not necessarily in that order.

· To help in backing up my camera photos, I added a Picture Viewer window.

· Right-click menus for easy access to common functions also followed.  

https://www.helpndoc.com


PickSync-help

67 / 70

In short, the more useful I found the program, the more I used it, and I was able to add further features which
seemed useful to me.  Although the program is now feature-rich, I have tried to group features logically and
to focus only on features which are complementary to its key function,  I have aimed for clarity, data safety,
and simplicity of use, and these have driven the program's evolution.  Some aspects have also been
streamlined for ease of use, or even removed when experience showed them not to be useful (an example is
a former 'Prune' tab for removing duplicate files).  

The web page and help file were begun at the end of 2009.
The program has now matured sufficiently that I am considering distributing it more widely. 

I hope that you will find PickSync as useful as I have done.  

Technical Note (for fellow geeks only!)

The early versions were written in Borland's "Delphi" version of the Pascal language.
Borland's development tools and programming environment were then excellent, but I disliked Pascal for its
needless verbosity, and so in about 2003 I converted the code to C# for the Microsoft .Net framework.

I currently use Microsoft Visual Studio 2015 to create and compile the program source code.
The left and right folder trees (and that in the 'Copy To' form) are implemented with the ShellBrowser .Net
components from Jam Software.  
This help file was created using HelpNDoc, and the installer (and associated uninstaller!) is built with Inno
Setup.

The code presently contains some disabled features which are subject to my testing and may be generally
enabled in a future release.  
Suggestions are always welcome!

History of PickSync - a short screenshot gallery

Progress has been slow (software engineering is not my day job) but steady, as illustrated below.

The very earliest working version of all (from 1996):
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A version from 2001:
   

From 2003:
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Early 2012 (note the more advanced central panel):

And the current (2017) version, with simplified central panel restored (advanced version can be
enabled under the 'View' menu):
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And there will be still more to come ... what features would you like to see added?

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

https://www.helpndoc.com/help-authoring-tool
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